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1. GETTING STARTED 

1.1 INSTALL AND UNINSTALL

Installing  is  a  simple  process.  Usually  your  file  will  be  saved  to  the  desktop  or  My 
Documents folder. The file by default will be called ERSetup.exe and running this will start the  
installation. During the installation, you will be presented with many pages containing options, 
including installation location and where to place the program icons. The uninstalling can be 
done either from the uninstall option found in the Effective Notes Reminder folder in the start  
menu, or via the Add/Remove Programs found in the Control Panel.

1.2 KEY FEATURES

AGENDA AND PROJECTS

These are the two main sections you will  find. The controls to change these exist in the 
status bar and the View menu. The status bar has two large buttons from which you can switch 
easily. Agenda page acts as your planner/scheduler where you can search via date ranges. The 
Project page is just that. It is your project (or many sub projects) and from there you can then  
choose to work within tree views and either the grid or the record's page.

CONTACTS WITHIN FOLDERS

The key features found in this program consist of having not only projects, but also smaller 
sub projects that can house contacts  and tasks independently.  This  makes running smaller 
sections of people, notes and events within separate parts,  but still  allowing the concept of 
moving people from one section to another. The fact of having contacts in a section does not  
limit the assigning of any person to whichever records you have.

SEARCHING AND FILTERING

Project search
Searching within your project is easy. Firstly, you need to be within your Project page, and 

from there choose the Search tab. This will then give you the opportunity to search within title, 
article  and folder  names plus many other locations.  In addition,  you can use the standard 
searching criteria such as whole word and matching case. The search text you enter is saved for 
a future time. The list can also be cleared later via right clicking on the pane and selecting  
“Clear list.”

Agenda search
Searching via Agenda can also be done just as easily. This is slightly different as you “filter” 

your results via the date range and via the record types. 

The date range can be filtered in many more ranges than in most other organizers. This was  
important when creating this program that this could be done. Filters include, 1 day, 5 days, 1 
week, 4 weeks, 2 months etc. This will be discussed more in Part 5 of this manual. The filtering  
of the record types can be seen more visually always in the status bar (at the bottom). This not  
only shows which type of records are available (with a number), but also which types are being 



used.

CUSTOM PRINTING

This is a brand new set of dialogs created solely to make the whole printing in software more 
streamlined. It consists of the older features that most people already know about. The features 
are initially included within a main dialog that acts as the preview window, as shown below. 
From this (on the left side is a pane) people can then select with simpler smaller dialogs to set  
margins, header and footers, portrait or landscape, or which printer to use. You can always see 
visually what settings you have chosen with the help of a small status box.

CONTEXTUAL ARTICLE TOOL BAR

This tool bar is broken into groups of icons, for instance: editing – cut, copy, paste etc. This  
removes the initial overwhelming experience of the older-styled long thin tool bars that have 
become so commonplace. The grouping firstly makes you go to the right section before clicking 
on a button. It also helps you choose features that you may not normally select. The grouping is 
done in Review, Editing, Insert, Arrange, Fonts, and Pictures (Filters and effects). The Fonts 
and pictures groups will never be shown together. They are contextual to whatever content is 
selected. If you select text then you have no need to edit the picture tools and vice-versa.

COLOR THEMES.

Colors for the main window and modify dialog can be set via the small set of buttons at the 
top right of the main window. This will change the color of the main screen to reds, yellows, 
greens, blues, system colors etc. These are preset colors that not only affect the main screen, 
but also the color in the modify dialog.

1.3 PURCHASING

Purchasing can be done effortlessly. We use an American company to which we let them sort 
out the financial side of the website. You can go to this website quickly from the Help menu. 
Clicking “Activate” will open the dialog below. They give you an initial page to where you enter 
the amount of programs to buy. From there you get a sub total and following on from that you  
then enter your bank details securely. Upon a successful purchase, you will receive an email, 
which will contain your serial number. Please keep this safe! The website link to go to is

 
http://store.kagi.com/?6FEVH_LIVE&lang=en

1.4 CONTACT US

You can contact me (Nigel Openshaw) via the one and only email address (easy for you and 
easy  for  me also).  If  you are  in  need of  help  for  whatever  reason,  be  it  program support, 
errors/bugs, purchasing or activation etc. then get in contact at nmoapps@gmail.com

mailto:nmoapps@gmail.com
http://store.kagi.com/?6FEVH_LIVE&lang=en


2. PROGRAM OPTIONS

The basic tools to make the process of using this program a bit easier can be found in just a  
few locations. These include the Wizard Helper and the Options dialog. In addition, you can 
right click in the main window’s background to access the view menu quickly. From there you 
can then show or hide features from view.

2.1 WIZARD HELPER:

The Wizard Helper is a quick-setup dialog that helps to configure the folders and files to 
help you organize your data. First off, you are presented with a dialog to choose either free or  
professional version. Depending on the time you have had the software installed the period 
may be over to try the professional version in trial mode. If you have purchased it then you can 
freely go between versions if you please. The differences between them include many features 
and advances to make organizing your data easier; for instance, you have the ability to export 
your agenda via email, print out or save to file.

 
The next page allows you to set the folder location. When you run the program, all your files  

are located within one folder and any sub-sectioned folders. This is to help you find your files 
much quicker than just leaving them all over your hard-drive. The main folder can store your  
main project files, backups, auto-saves and hyperlink list files to name but a few. Upon pressing 
finish will then create (if not already existing) folders for you.

2.2 OPTIONS DIALOG:

The options dialog allows you to tweak the running of the program to fit your own needs. If  
you prefer to have certain aspects the way you like then this dialog can help you.

FOLDER LOCATION

The folder location is where your folders and files can be found. You can choose where the 
main reminders folder will be created. You will be asked to restart the program upon change of 
this location.

START-UP

Launch Program at start-up
This allows the program to start at the beginning of the opening of Windows.
 
Section to start with
This allows you to by default start with either the Agenda page or the Project page.
 
Minimize to system tray on start-up
This allows the program to be discreetly run at start-up with only the tray icon being shown.
 
Minimize to system tray on close
This allows you to close the program from view and then hide away in the system tray.  

Unchecking this will then close and terminate the program upon close of main dialog.



 
Minimize to system tray on minimize
This allows you to minimize the program from view and then hide away in the system tray. 

Unchecking this will then minimize to the task bar only. 

ITEM SETTINGS

Item default values
Here you can set the default record type and color. This could be useful if either you want to 

work within groups or all your records will be the same style. The record types include contacts, 
events, journals, memos and tasks. If you prefer to use only one or so types then this can help. 
Also the default record can be set to various colors such as red, blue, yellow, silver, orange and 
many more.

 
Loading settings
When you open a project file, you can see the contents in a tree view as either a list of folders 

or all contents including the files. As a default, this will be turned off. If you have just a handful  
of records then this can help considerably, but if you have hundreds of records, it may be more 
advisable to work with this option turned off. It makes it easier if folders are not hidden at the 
bottom.

 

PROJECT BACKUP

Auto-save
This feature allows any unsaved work to be backed up as a separate file. This feature is only  

available in the professional version. It creates a file with the same name and the date at the 
point of saving. The Auto-save’s time can be changed to another value in minutes from one to 
as many as you like. These are saved in an auto-save folder that can be found in the main 
reminder files folder location.

 
Backup
You can backup from 1 day to 6 weeks. As with the auto-save, you can find separate files in a 

backup folder. This creates a file in the same manner as Auto-Save. A prompt on the dialog of 
the next backup can be seen next to these options.

 

FORMAT TOOLS

Font list manager
The font list manager works by allowing you to use only the fonts you like. There are two list 

boxes. The first houses the main collection of fonts that are on your computer. The second 
shows a list of fonts that you have chosen. During the use of viewing your articles, if a font has 
not been classed as one of your favorites then it will be temporarily installed into the drop 
down list.

 
Color drop down list size
Wherever you see a drop down color palette,  you have the opportunity of  allowing four 

different  styles.  The  different  styles  are  viewable  with  different  variations  and  amounts  of 
colors. Below are the four styles.

• 9 by 3 (27)



• 8 by 8 (64)

• 16 by 8 (128)

• 24 by 10 (240)
As you can see in the brackets, there are the numbers of colors available. For simple editing 

and typing then the first two would be sufficient.

ARTICLE FORMATTING

Fonts theme
The fonts theme is a simple default theme editor that keeps your personal choice of font-

name, font-size and color for every time you use them. Whilst the main window is open, click 
on the default format button. This will then change the text back to using these settings. A 
quick settings button is also available.  This works by setting the theme values to whatever 
formatting you have chosen in the current article.

ARTICLE LAYOUT

Ruler styles
The ruler styles allow you to change the style of the ruler. You have the choice of centimeters 

or inches. This does not turn on or off your ruler. That can be done from the View Menu and 
then Show Ruler.

 
Word wrap
Word wrap can change the positioning of the text in the main article window. It gives you 

three options. First, you can wrap to the window. This allows you to use the whole space, no 
matter how wide your screen is. Secondly, you have the option of wrapping to the document. 
This  sets  the  right  margin to  the  width of  your  page.  This  will  set  the size  minus of  your 
margins. E.g. if you have A4 paper with 1 inch margins, then you will have a page size of 6  
inches.

ARTICLE PROOFING

Article proofing consists of two main areas. First, there are the spell checker tools/settings. 
Then there are the auto correct settings.

Spell checker settings
The spell checking has many options that can control how you can check your work.
 
Language
This allows you to switch (with a restart) from American English to British English or vice-

versa easily. Although it say a restart is needed, if you haven’t launched the spell checker as yet 
then you can safely change between files, but one you have checked your spelling then it will 
definitely mean a restart is needed.

 
Filtering
Filtering allows you to allow or disallow the use of numbers, special characters or uppercase 

words within your spell checking. This can be useful 
 
Dictionary
This controls the load-up of the dictionary. As with most spell checkers they can take time to 



load their dictionaries. These options allow you to say when you would like them loaded. To 
load on the first use means it will be free from loading of the dictionary at start-up. This makes  
the program start much faster. This is helpful if you do not use it that often. The other option of 
loading at start-up means it will be loaded every time the program starts.

 
Auto correct
Auto correct can actively monitor what you type in and change accordingly. Depending on 

what you type after the word or shortcut be it a space or enter pressed, then you will see a  
change. You can setup many of these fields yourself. They can be shortcuts or adding characters 
to words that you commonly miss or you spell wrong. Remember though, this should be a quick 
fix solution and not something to fix your errors; otherwise you could become dependent on it 
helping you too much.

THEME COLORS

Theme colors can be found in the top bar along side Help and Options. The themes are 
available in many different colors and shades. They are grouped up into main colors such as 
reds,  pinks,  yellows,  oranges,  greens,  cyan’s,  blues,  purples,  grays,  browns  and  windows’ 
system colors. The windows colors are based on common system theme colors. These are useful 
if you prefer theme that matches much closer to your current interface.

CUSTOMIZING LAYOUT

Customizing the layout of the program can be done extensively. Some aspects are based on 
either the Agenda or on the Project pages, but also some features can be modified that would 
change both pages. Such features include the ability to show or hide the top bar and the status 
bar.

 
As for the Agenda, features that can be changed include showing or hiding the preview pane 

and the calendar. Also with this, you can filter the schedule results to show whichever record  
type you prefer. As the record types are contacts, events, journals, memos and tasks, you could 
therefore show just memos and tasks.

 
The project page also has some customizing options. These cater more for the article. The 

article is the main rich text-editing window that shows to the right when you click on a record.  
Here  you can  show or  hide  the  contextual  format  bar  and ruler.  If  you  are  not  using  the  
professional version then you will not see the ruler. 



3. CREATING PROJECTS

Creating projects can be done for many reasons. As with most organizers and reminders, 
they do not seem to want you to run more than one database. This is somewhat of an exclusive 
process, because if you look at other software titles albeit in different subjects, they do not push 
you to add everything into just one file. Most people are aware of creating files, so with this  
software we have allowed the opportunity to not only create but to view and reopen other 
project files. You can see the past eight projects from the recent list situated in the file menu.

3.1 NEW

Whilst creating new projects is easy, the program has been made to look just one place. This 
is the reason for the Reminder Files folders. This allows all files to be found quickly in one 
location. You could create files for many different subjects etc. If you make quite a number, 
then it might be a good idea to create sub folders. Creating new files is done quickly. After 
choosing to create a new file, you will then be prompted to save it. This is to make the future  
saving and loading on start of program much easier. If you create a new file and do not save it  
then it will be saved, but with a temporary file name, then it is up to you. This will also affect  
your saving of the backups and auto-save.  You could also create a new file via the Wizard 
Helper. This will create a new file in wherever you Reminder Files folders will be. 

SAVE AND NEW
Whilst having the Modify dialog open you can also “save and new”. This allows you to create 

many records on the go rather than reopening the dialog for multiple entries.

3.2 OPEN

Opening files can be done in a few ways. Firstly, you could load from the recent list. This 
hosts the last eight files you would have opened. Choosing a file from here will make it move to 
the top of the list. Alternatively, you could load from the Open dialog. This would show you 
your Reminder Files folder and the initial contents. If you have made sub folders with files in 
those then you would need to search yourself, as every time the dialog will be opened at the 
root folder. After choosing to view a file and then closing Effective Notes Reminder, you will  
then be shown that same file the next time you start.

3.3 SAVE

Saving  is  usually  done  automatically.  If  you  feel  you  want  to  save  (for  instance,  your 
computer has a history of crashing) then there is no problem to do so. Every time you close 
Effective reminder, and work is still unsaved then it will be saved automatically. If the file has 
not been saved yet, then you will be prompted to save the current file. You will be encouraged 
to save in the Reminder Files folder.



3.4 SAVE AS

Save As can be used if you want to duplicate the current file. The file you create will now be 
the main file that Effective Notes Reminder will use. If you want to make a backup then this can 
be done, but as said, “The backup” would then be your main file.



4. CREATING AND ORGANIZING RECORDS.

Creating  and  organizing  records  can  be  done  in  either  Agenda  or  Project  pages.  This 
therefore cuts down on moving from section to section. 

4.1 ADD

Adding records can be done quickly. Pressing “Ctrl+N” will bring up the Modify dialog that 
creates the records. To help with creating new records there is a feature in the Options dialog to 
allow you to set by default which type of record you prefer. This means that when you press 
“Ctrl+N” it will  open your choice. The types to choose from include contact, event, journal, 
memo and task. You can see your preference via the position of the shortcut in the drop-down 
menus. These can be found at “Create record" tool bar icon and in the Record menu.

Adding records into new folder names will  automatically create those folders. The folder 
system is automatically monitored so there is no need to do anything yourself.

4.2 MODIFY

Modifying the records can be done either from the Modify dialog or from the grid and article 
windows. The Modify dialog has many more fields to choose from, but if you need just quick 
changes then the grid and article are nearby for you. There is a shortcut key “Ctrl+M” from 
which you can use. It can be found also in the tool bar; “Modify record” and also in the Record 
menu

4.3 REMOVE

Removing of records is very simple. There is a shortcut key “Ctrl+D” from which you can 
use. There is no prompt for deleting records, so be careful. Whereas, deleting a folder (with all  
records inside it) you will be prompted to delete. It can be found also in the tool bar; “Delete  
record” and in the Record menu.

4.4 CREATE FROM EXISTING

This allows you to create a cloned record with all contents the same. This can be helpful for 
speeding up your inserting of entries. It can be found in the tool bar, “Create from existing” 
icon and the “Record menu.”

4.5 CREATE A STICKY NOTE

Creating sticky notes is so easy. Once you have your record made, you can click on either the 
yellow toolbar icon or from the Edit menu  and Create Sticky Notes. The sticky notes will copy 



the connected record's details. Things like type and color will affect the visual display. The main 
part  of  course  is  the  article  text.  Here  you can  edit  the  text  and save back to  the  project. 
Alternatively if you have a record open to be modified and a sticky note already exists, then on 
the point of saving the record, the sticky note will update itself.

4.6 OPEN RECYCLE BIN

The Recycle Bin shows all records that have ever been deleted. You can see an icon available 
in both Project page and Agenda page. It changes just the same as the main Windows Recycle  
bin in that when empty it shows a different icon to when it it full (or at least one record has 
been deleted. If you have over the icon it will then tell you in the popup a count of how many 
record are so far in the recycle bin.

After clicking on either the toolbar icon or from the Edit menu  and Open Recycle Bin, you 
will see the dialog. In here are three main options to choose from. First, is Restore. This allows  
you to send the record back into the project. Second, allows you to remove a record from the 
project completely. Third, allows you to clear all contents from the bin.

4.7 MOVE TO NEW FOLDER

Moving a record to a new folder is a quick and simple feature. It is meant to be able to edit a  
record’s  folder  without  having  to  open the  main  Modify  dialog.  This  can  be  found  in  the 
“Record menu.”

4.8 EDITING FOLDERS:

There is a right click menu available for the tree view that then allows to quickly editing the 
folders. Depending on where you have selected before right clicking then you will see different 
menus. For the Folder menu, you will have the following options:

• Expand and collapse. 

• Rename folders.

• Delete folders and contents.

 
 
 
  
 



5. VIEWING AND EDITING RECORDS

5.1 VIA AGENDA

 

FILTERING WITH DATE

Filtering via the date can help cut down the records on screen. As with most schedulers and 
organizers the range always felt a little limited, so here we made a larger group of preset ranges 
that can quickly show you what you have. No matter which one you have selected the printing 
and exporting of the report will change accordingly. Below is the current range of filters.

• 1 day
• 5 days
• 1 week
• 2 weeks
• 4 weeks
• 1 month
• 2 months
• 6 weeks
• 4 months
• 6 months
• 1 year
 
 
 
The above filters are only present in the professional version. The free version has only half  

of them:
• 1 day
• 5 days
• 1 week
• 4 weeks
• 1 month
• 4 months
• 1 year
 

FILTERING SECTION TYPES

As well as filtering by date range, you can also filter via the record types. This is especially 
useful if you do not intend to use all the categories. As the record types are contacts, events, 
journals, memos and tasks, you could therefore show just memos and tasks. 



5.2 VIA PROJECTS

FILTERING WITH TABS

Home
The home tab shows all records in your project file. They are structured in a tree view layout.  

There is only one folder level and records can be found within this. Selecting either “All” or a 
folder will display the grid from which general details can be edited quickly. Selecting a record 
will therefore show the record bar, tool bar and article. Double clicking on these records will 
then show the modify dialog.

When the grid is visible, you will see many columns. These are, Sub Type, Title, Folder,  
Date, Priority and Status. 

Search
Search allows you to look at only files that contain the criteria asked for. The layout of the  

results is the same as that found in the Home tab. Above the list are a few check boxes as well 
as the text search box and execute button. The check boxes cover a few specific areas. These are 
folder names, include record titles, and include notes and the more general searching tools:  
match case and whole word only. Using the first three check boxes is done so that you can 
exclude them more than include. By this, we mean if you do not want to search in the article  
notes, (for the reason of there may be text too general for the search) then you can simply 
ignore from being searched. The search for drop down box will save the text that you have 
looked for, so making later searches always at hand. After searching and clicking on the folders, 
you will see contents of those folders, but only if those records match the criteria. This will not 
be exactly the same folders as in the home tab.

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
  
 



6. CREATING AN AGENDA REPORT

Creating Agenda reports can only be done from the professional version. There are three 
different  ways  to  create  reports.  They  cover  printing,  sending  by  email  and  saving  as 
documents.

 
 

PRINT

Printing your documents can be done in a few clicks. The only hard thing to do is to choose 
which records to print. So once, you have chosen your record from the filtering, click the Print 
button. This will then open the print dialog. From there it is up to you as to the orientation,  
margins etc. If you want to print just the article then click print from the Record Menu. This  
firstly  gives  you an option to  include the  title  and date  before  going on and viewing  your 
preview. Every time you want to print in Effective Notes Reminder, you will be presented with 
the print dialog. The idea is to get you to check before printing 20 copies of the same file before 
proofing.

SAVE AS A FILE

Saving  as  a  file  is  a  good alternative.  If  you  later  want  to  archive  or  send them as  an 
attachment or even add more content then all you have to do is choose where to save. They will 
be saved in RTF format, which allows you to edit and add formatting and images. 

 
 

EMAIL TO A CONTACT

Sending by email  is  also a simple process. You can send via your default email and the 
details will be the main body of the message.

 

 



7. SETTING ALARMS

Alarms show a small dialog on screen accompanied with a bright but short audio burst. The 
dialog shows the general details, including at the top: Record Type and Date and time. Below 
that are the Main title/ description along with a photo (if used). Next is a read-only window 
that shows the main article text. Lastly, at the bottom you will find the command buttons to 
perform actions. The buttons to choose from are Open, Delete, Print, Email, Website and Sticky 
note. This dialog can be found in the bottom right corner of the screen. This can be dragged and 
resized. The color of the dialog will be set to the color of the record. 

If you decide to create a sticky note from your popup, then as said before it will copy the 
traits from the popup and the main record. This can be useful to transform the note from a  
popup to a fixed note, as the next time you start your computer all your notes you have set will  
be visible.

 
 
 
 
 
 
 
 
 
 

 
 
 

 
 



8. DETAILS WITHIN A RECORD

Records  show many details  no  matter  where  you  view them.  They  are  supposed  to  be 
generic, but then again have specific fields for the task. There are a few different fields on show 
such as, title and date. These and much more fields can be found within the Modify dialog. This  
dialog is split into tabs. Although to the left of the dialog, you will always see a small group of 
fields.  These  fields are  the  main and important  fields  for defining the  record.  These fields 
include type, sub type, color, folder, location and a picture. The tabs cover the main article, 
record status, contact details, and personal fields.

8.1 MAIN ARTICLE

This is a simplified version of the main screen when you choose a record. It has the Fonts  
type  and  size  along  with  most  of  the  features  from  the  font’s  tools,  such  as  Bold,  Italic, 
Underline and Text color. In addition, there are some arrange tools such as Bullets, Alignment 
and Indentation.

8.2 RECORD STATUS

The status tab houses the date and time along with a few other status fields. The date and 
time are setup to deal with from and to respectively. This can also be set to be 'whole day 
event.” This means there is no fixed time, but rather something, that needs to be done or occurs 
just in that day. This can be useful for general tasks. A word of warning on setting alarms for 
many records set with all day events. This would mean that when you start the program that 
day you would receive all of your alarms one by one. For many alarms in one day, it would be  
wise to organize to specific times. There are also some presets of dates for quick settings. As 
well as the three main buttons, you can find more options if you select and right click on the 
actual date box.

 

PREVIEW TIME

You can set a preview time for your alarm. The date preview can be anything from 5 minutes 
to 4 weeks. If you have selected an all day event, then the preview time will differ. You will not 
be allowed to set a preview with time, but just days. This is because the event would have no set  
time.

STATUS AND PRIORITY

This is more preferable for tasks and events, but can be used for whatever you like. You can 
set the status of your records to anything from completed, do next, canceled, postponed, sub 
task, on going, deferred etc. These might not always be preferable, so you can type into the box 
and make a custom status. There is also a percentage option you can use to mirror your status. 
The same also applies to the priority. You can either use the preset or create your own. The 
presets include very low, low, moderate, high, very high and critical.



8.3 CONTACT DETAILS

These fields are more preferable for contacts, but the same as above applies, you can use 
how you like. The fields here cover most details related to a contact. These include the main 
addresses for both home and work. You can include phone numbers too. These cover a mobile 
and the home and work numbers.  Also are included primary email  and website addresses, 
along with two more alternative addresses respectively.

8.4 PERSONAL FIELDS

The personal fields cover names and dates of the user, contact or person for whomever this 
will save. Along with the main person, you can also log his/her spouse/partner and three more 
dates, for example children or parents.

 
 
 
 

 
 



9. EDITING THE ARTICLE

The article is a rich text based editor. There are tools for editing text and pictures. For those 
who are not aware of “rich text”, the best example to give is Windows WordPad. This allows you 
to be creative with fonts, colors and arranging. The tools for you here are grouped up to show 
you in a more understandable way rather than the standard and format tool bar that have been 
over done and just not useful or intuitive. Below is a list of tool bar items. They are broken up to 
the layout found on the main screen.

 
 

9.1 REVIEW

SMALL SET OF TOOLS TO USE AFTER YOUR ARTICLE HAS BEEN MADE.

• Spell  checker:  This  checks the spelling of your article  Settings for your spell 
checker can be found in the Options dialog.

• Find and replace: These tools help to find and replace text in your article

• Save as draft: The saves the current article to a rich text document.

• Print article: This lets you print just the article using the main printing dialog
 
 

9.2 EDITING 

A GENERAL SET OF TOOLS FOR MODIFYING YOUR ARTICLE.

• Undo: This undoes the previous action.

• Redo: The redoes the previous undone action.

• Cut: Cut the selection to the Clipboard.

• Copy: Copy the selection to the Clipboard.

• Paste: Paste the contents of the Clipboard to the article.

• Select all: Select all of the article's contents.

• Erase: Erase the selection from the article.

9.3 ARRANGE

• Alignment: Alignment has four options; Left, Center, Right and Full Justify that 
allow you to position your paragraphs.                

• Line spacing: Line spacing has many presets for the height of your lines. If you 
need custom line size then open the Paragraph dialog.

• Bullets: The bullets list allows you to quickly group up items.

• Indent: Indent moves the paragraph away from the left margin.

• Outdent: Outdent moves the paragraph back toward the left margin.



• Tab stops: These allow you to control text within tabbed key presses. This is the 
actual dialog, but the tabs can be set with just one click on the ruler bar.

• Paragraph: The paragraph dialog has alignment, line spacing and indentation. 
The line spacing has more custom options including space before and space after 
the paragraph.

 
 
 

9.4 INSERT

• Icons: The icons are a set of small images portraying certain objects.  In addition, 
there is a collection of emoticons.

• Pictures: This shows a dialog, from which you can then browse your computer for 
pictures.

• Hyperlinks:  The hyperlinks  dialog allows you to  insert  a  link,  which could  be  an 
email,  web,  file,  FTP  address  etc.  These  links  can  be  imported  or  exported  for 
portable access.

• Documents: The documents that can be inserted can be text and rich text files. This 
can be from simple letters to computer code or to-do lists.

 
 

9.5 TEXT EDITING TOOLS:

 

FONTS

• Fonts: The fonts list houses all the fonts you have chosen. If you would like to add 
more or remove some then, click on the “Custom...” at the bottom of the list.

• Font sizes: Font sizes range from 7px to 72px.

• Bold: Apply bold style to the selected text

• Italic: Apply italic style to the selected text

• Underline: Apply underline style to the selected text

• Subscript Apply subscript style to the selected text

• Superscript: Apply italic style to the selected text

• Default format: Make the text default to the style in the Options dialog.

• Format paint: Copies format from one location to another. First, you select what you 
want to copy. Then click the button and finally click and drag in the article. This will 
then cover where you would like to apply the format.

• Font color: The font color has two buttons. The first is a simple painter that applies 
the color to wherever selected. The second has a drop down palette that allows you to  
choose a new color.

• Color picker: This sets the color in the tool bar to the selected color.
 
In addition, font properties dialog. This can be found in the article menu from the main tool  



bar and the right click menu. It houses the basic font tools, with a preview window to help.
 

PICTURE EDITING TOOLS

When you select a picture these options will replace the font’s icons in the tool bar.
 
Filters
• Brightness: This has a drop down menu with values from +40% down to -40%
• Contrast: This has a drop down menu with values from +40% down to -40%
• Saturation: This has a drop down menu with values from +40% down to -40%
• Borders: A border can be drawn around the selected image.
• Soften: This will apply a softening effect to the image.
• Sharpen: This will apply a sharpening effect to the image.
• Gray scale: This will apply a gray scale effect to the image, removing all color.
• Negative:  This will apply a negative effect to the image.
 
Adjust
• Flip vertically: This will flip the image vertically.
• Flip horizontally: This will mirror the image horizontally.
• Rotate left: This will rotate the image to the left.
• Rotate right: This will rotate the image to the right.
• Save picture: You can save the actual image as a bitmap file.
• Increase size: You can increase the size of the image. Be aware that the quality will reduce.
 Decrease size: You can decrease the size of the image.
• Crop image: This opens a dialog to allow you to crop the image to a small part of it.
 

9.5 RULER

The ruler has a few features that you can find in the list (format bar) above. The bar has 
three buttons tot he left and one to the right. The three to the left are:

 
• Left indent:  This controls all of the indentation.
• First line indent: This allows you to set the indent for just the first line
• Hanging indent:  This allows you to push the indent either more or less of the indents 

value.
 
The right indent allows you to set how far right the text will go. Left clicking on the bar will  

set a tab stop. If you hover over these and press left again, you can move them. Alternatively, if  
you right click then you can remove them. Right clicking on the actual ruler will open the tab  
stops dialog. In addition, double clicking the ruler will open the paragraph dialog.

 
 
 



 



10. DIALOGS IN DEPTH

10.1 PRINTING

The printing has a couple of dialogs. This is accessed via the main dialog that shows the 
main page preview. From there you can access the following dialogs.

 
• Header and footer
• Margins
• Printer types
 
The header and footer dialog allows you to setup for title, date and time, page number, file 

name and name along with lines. The margins dialog sets up your margins for left, right, top  
and bottom. They can be linked together, so therefore they can be synced. The printer types will 
show only the pages types that the printer can capable. As well as these, you can change the 
orientation.

 

10.2 HYPERLINKS

The hyperlinks dialog can cater for a few different types of links. These are websites, emails, 
files and FTPs. The website has an option. You can create either normal or secured.

You have the option of importing and exporting the list. In addition, you can open the links 
to the default programs. 

 
 

10.3 SPELL CHECKER

If  a  file  has  misspelled  words  then  the  dialog  will  pop  up.  This  can  be  very  useful  for 
common errors. After checking you should proof read it again and later as well to get a fresh 
feel when reading it.

 
If you know that the word selected is OK, then click either Add or ignore. If Add is selected 

please, make 100% sure you want to add it. Ignore All can be useful for names of people and 
places.

 

• Add: When you add a word to the dictionary the word goes into the main dictionary 
file.

• Ignore: ignores just this one occasion.

• Ignore All: ignores all following words like this.

• Replace: Replaces just this one occasion.

• Replace All: Replaces all following words like this.
 
If  you make errors repeatedly then you could add them to the Auto Correct,  which will  

change them for you. As said before, you should not get used to it fixing them for you.



11. SHORTCUT KEYS

Ctrl+A: Select all (article)
Ctrl+B: Bold (article)
Ctrl+C: Copy contents to Clipboard
Ctrl+D: Delete record
Ctrl+E: Align Center (Project) 
Ctrl+E: Email report (Agenda)
Ctrl+F: Find text
Ctrl+H: Replace text
Ctrl+I: Italics
Ctrl+J: align full justify
Ctrl+K: Insert Hyperlink
Ctrl+L: Align Left
Ctrl+M: Modify dialog
Ctrl+N: Create a new record
Ctrl+O: Open a project file
Ctrl+P: Print record
Ctrl+R: Redo undone action
Ctrl+R: Print Report
Ctrl+S: Save the project file (Project)
Ctrl+S: Save report (Agenda)
Ctrl+T: Indentation
Ctrl+U: Underline
Ctrl+V: Paste clipboard contents
Ctrl+W: Wizard Helper
Ctrl+X: Cut contents to Clipboard
Ctrl+Z: Undo action
 
 

AGENDA:

F1: Help
F2: View contacts
F3: View events
F4: View journals
F5: View memos
F6: View tasks
F8: View Agenda page
F9: View Project page
F11: Help
F12: Go to today
 
 
Ctrl+F12: Go to next range



Shift+F12: Go to previous range
Ctrl+F1: View range by day
Ctrl+F2: View range by work week
Ctrl+F3: View range by week
Ctrl+F4: View range by 2 weeks
Ctrl+F5: View range by month
Ctrl+F6: View range by 2 months
Ctrl+F7: View range by 4 months
Ctrl+F8: View range by 6 months
Ctrl+F9: View range by year
 

PROJECT:

F1: Help
Shift+F1: Start Wizard
F2: Spell checker
F3: Find next
F4: Format paint
F8: View Agenda page
F9: View Project page
F11: Article Preview
F12: Save as draft
 
 
Ctrl + Space: Default formatting

Ctrl+F1: Line spacing value: 1.0
Ctrl+F2: Line spacing value: 1.5
Ctrl+F3: Line spacing value: 2.0
 
 Shift+12: Collapse Folders
Ctrl+F12: Expand Folders
Ctrl+Shift+F12: Edit Folders
 



12. LICENSE

END-USER LICENSE AGREEMENT FOR EFFECTIVE ASPECTS IMPORTANT PLEASE 
READ  THE  TERMS  AND  CONDITIONS  OF  THIS  LICENSE  AGREEMENT  CAREFULLY 
BEFORE CONTINUING WITH THIS PROGRAM INSTALL Effective Aspects End-User License 
Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) 
and Effective Aspects.  For  Effective  Aspects  identified above which may include associated 
software  components,  media,  printed  materials,  and  "online"  or  electronic  documentation 
("Effective Notes Reminder").  By installing,  copying,  or otherwise using the Effective Notes 
Reminder, you agree to be bound by the terms of this EULA. This license agreement represents 
the entire agreement concerning the program between you and Effective Aspects, (referred to 
as "licenser"), and it supersedes any prior proposal, representation, or understanding between 
the parties. If you do not agree to the terms of this EULA, do not install or use the Effective 
Notes  Reminder.  The  Effective  Notes  Reminder  is  protected  by  copyright  laws  and 
international copyright treaties, as well  as other intellectual property laws and treaties. The 
Effective Notes Reminder is licensed, not sold. 

1. GRANT OF LICENSE
The Effective Notes Reminder is licensed as follows: 
(a) Installation and Use
Effective  Aspects  grants  you  the  right  to  install  and  use  copies  of  the  Effective  Notes 

Reminder on your computer running a validly licensed copy of the operating system for which 
the Effective Notes Reminder was designed [e.g.,  Windows 95,  Windows NT, Windows 98, 
Windows 2000, Windows 2003, Windows XP, Windows ME, Windows Vista, Windows 7].

(b) Backup Copies
You may also make copies of the Effective Notes Reminder as may be necessary for backup 

and archival purposes.
 
 
2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS
(a) Maintenance of Copyright Notices
You must not remove or alter any copyright notices on all  copies of the Effective Notes 

Reminder.
(b) Distribution
You may not distribute registered copies of the Effective Notes Reminder to third parties. 

Evaluation  versions  available  for  download  from  Effective  Aspects’  websites  may  be  freely 
distributed.

(c) Prohibition on Reverse Engineering, Decompilation, and Disassembly
You may not reverse engineer,  decompile, or disassemble the Effective Notes Reminder, 

except  and  only  to  the  extent  that  such  activity  is  expressly  permitted  by  applicable  law 
notwithstanding this limitation. 

(d) Rental
You may not rent, lease, or lend the Effective Notes Reminder.
(e) Support Services.
Effective  Aspects  may  provide  you  with  support  services  related  to  the  Effective  Notes 

Reminder ("Support Services"). Any supplemental software code provided to you as part of the 
Support Services shall be considered part of the Effective Notes Reminder and subject to the 
terms and conditions of this EULA. 

(f) Compliance with Applicable Laws
You must comply with all applicable laws regarding use of the Effective Notes Reminder.
 



3. TERMINATION. Without prejudice to any other rights, Effective Aspects may terminate 
this EULA if you fail to comply with the terms and conditions of this EULA. In such event, you 
must destroy all copies of the Effective Notes Reminder in your possession.

 
4. COPYRIGHT. All  title,  including but not limited to copyrights, in and to the Effective 

Notes Reminder and any copies thereof are owned by Effective Aspects or its suppliers. All title  
and intellectual property rights in and to the content which may be accessed through use of the 
Effective Notes Reminder is the property of the respective content owner and may be protected 
by applicable copyright or other intellectual property laws and treaties. This EULA grants you 
no rights to use such content. All rights not expressly granted are reserved by Effective Aspects. 

 
5. NO WARRANTIES. Effective Aspects expressly disclaims any warranty for the Effective 

Notes  Reminder.  The  Effective  Notes  Reminder  is  provided 'As  Is'  without  any express  or 
implied warranty of any kind, including but not limited to any warranties of merchantability, 
non-infringement,  or fitness of  a particular  purpose.  Effective Aspects  does not warrant  or 
assume responsibility for the accuracy or completeness of any information, text, graphics, links 
or  other  items contained within the  Effective  Notes  Reminder.  Effective  Aspects  makes  no 
warranties respecting any harm that may be caused by the transmission of a computer virus, 
worm,  time bomb,  logic  bomb,  or  other  such computer  program. Effective  Aspects  further 
expressly disclaims any warranty or representation to Authorized Users or to any third party.

 
6.  LIMITATION  OF  LIABILITY.  In  no  event  shall  Effective  Aspects  be  liable  for  any 

damages (including, without limitation, lost profits, business interruption, or lost information) 
rising out of 'Authorized Users' use of or inability to use the Effective Notes Reminder, even if 
Effective Aspects has been advised of the possibility of such damages. In no event will Effective 
Aspects be liable for loss of data or for indirect, special, incidental, consequential (including 
lost profit), or other damages based in contract, tort or otherwise. Effective Aspects shall have 
no liability with respect to the content of the Effective Notes Reminder or any part thereof, 
including but not limited to errors or omissions contained therein, libel, infringements of rights 
of publicity, privacy, trademark rights, business interruption, personal injury, loss of privacy, 
moral rights or the disclosure of confidential information. 

 
 
Copyright 2010 Effective Aspects
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